
May 28, 2007 

 

To: The Broker’s Workstation Users 

 

Dear Valued Client: 

 

RE: The Broker’s Workstation – Important Releases and Changes 

 
Custom Software Solutions Inc. (CSSI) is pleased to announce the release of the following enhancements 

and new features to its The Broker’s Workstation (TBW) product. 
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1. New Bulk Service Charge Function 

 

Note: This new feature is only available with SQL 2005 server or SQL 2005 

Express.  We encourage everyone to please contact our Support Team for 

upgrade information. 
 

The Broker’s Workstation Business Management System contains tools to manage a brokerage’s 

accounts receivable including the ability to apply service charges to all qualifying accounts. The 

system offers users flexibility in terms of what groups of accounts to apply service charges as 

well as user definable rules for the application of charges. 

 

Key Concepts: 

 

Open Items: 

 

A key concept to the operation of The Broker’s Workstation accounts receivable system is its 

open item approach. In the open item system, we are concerned not only with what amount an 

account owes, but what particular items are owing. To make the most of the open item approach, 

it is essential to close open items by means of matching them with the corresponding transaction 

that closed or settled it. At the simplest level, an invoice is an open item until it is paid and the 

receipt is closed to it. In the Broker’s Workstation, open items are closed by the following 

means: 

• The allocation of a payment to the invoice via the receipt allocation grid 

• The allocation of a payment to an invoice via the client folder ledger card 

Reconciliation view 

• The allocation of one item to another via the accounting side accounts receivable 

reconciliation tool 

• Automatically, behind the scenes as in the case of certain folder transactions 

including Bad Debt, Waive Small Balance, Service Charge Adjustment 

 

Open items are important for the computation of a service charge on an account. In general, a 

closed item should not attract a service charge, so those items are excluded from the evaluation. 

If an item is paid but it is not closed to its payment via one of the means above, the system will 

treat it as being unpaid because it has no means of linking it to the payment, so it may attract a 

service charge. Therefore the accuracy of the service charge calculation is directly related to the 

degree of completeness of the closing of open items within the organization.  

 

For best results, it is recommended that users clean up their accounts receivable open items and 

then maintain a policy of closing open items. A printout of the Accounts Receivable Aged Detail 

Report can be a useful tool for pointing out accounts that have open items in need of closing. For 

example, there is a high probability that open debit and open credit items of equal amounts are 

items that should be closed to each other. 

  

Due Dates: 

 

Implicit in the service charge process is the premise that an open item that is overdue should 

attract a charge while one that is not overdue should not. The determination of an open item’s 

overdue status is based on its due date versus the effective date of the service charge calculation. 

That is, if the service charge run is being calculated with an effective date of June 30, 2006, an 

open item will be overdue if its due date is less than the effective date of the calculation (due 

June 28, 2006 or earlier in this example). 

 



Due dates are applied to insurance policy transactions and miscellaneous client folder ledger card 

debits based on the rules set up for the organization on the Invoices tab in Demographics.  

 

Process Overview: 

 

The Broker’s Workstation bulk service charges function is built around the following process 

framework: 

Setup the organization rules and preferences 

Maintain accounts receivable, close open items 

Periodically calculate bulk service charges 

Review and manage the calculated bulk service charges 

Post the bulk service charges 

Deal with any problems in posted service charges. 

 

Getting Started: 
 

User rights will have to be set up for each appropriate user before any bulk service charges can 

be used. To do this you will need to go to your tools menu -> administrative -> user manager. 

Select appropriate user and hit rights. Under the Accounting tab select appropriate access to 

service charge cycles and service charge cycle options, and then apply appropriately (Figure 1.1). 

 

Figure 1.1 

 
 

Before bulk service charges can be calculated, the system must be set up with the organization’s 

preferences. For organization’s with multiple Agencies, Branches and Departments, preferences 

can be set for each Agency-Branch-Department. 

 

To set up the service charge preferences, navigate to and double click Accounts Receivable on 

the Accounting tree and then click the Service Charges tab on the bottom of the viewer. This will 

cause the display of a service charges toolbar at the top border of the viewer as reproduced below 

(Figure 1.2): 

Figure 1.2 

 
 

 

The toolbar icon on the far right depicting a file folder and a hammer is used for setting bulk 

service charge options (Figure 1.3). When it is clicked, the user is presented with the option form 

that appears as follows (Figure 1.4): 

 

Figure 1.3 
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Figure 1.4 

 
 

The first controls on the form related to the selection of the desired Agency-Branch-Department 

to be set up. If the organization has only one Agency-Branch-Department (ABD), that ABD will 

be the default. If the organization has multiple ABDs, the controls will default to that of Agency 

1, Branch 1 and Department 1. 

 

Once the desired ABD is selected, the rules and preferences for the calculation and handling of 

service charged for that ABD can be set as follows: 

 

Calculate service charges on items over x days overdue. This is a means of providing a grace 

period for slightly overdue items. If 5 is the selected value, then a service charge will not 

be calculated on an overdue item unless it is more than 5 days overdue. 

Don’t apply service charges of less than x. This is a control to apply a minimum service 

charge value. If the calculated service charge is less than this selected value, no service 

charge will be applied. 

• Calculate service charges for active clients/brokers only. If these are selected, the system 

will verify that each folder or broker status is set to active. If the folder/broker is not 

active, no service charge calculation will occur. Use of this option will streamline the 

calculation process. 

• Create printable invoices for Bulk Service Charges. These controls set up the rules for the 

creation of printable invoices for service charges levied on folders or brokers. Select 

these if there is a desire to print and send invoices for the applied service charges to these 

classes. 

• Create printable invoices for Bulk Service Charge Reversals. These controls set up the 

rules for the creation of printable invoices for service charge adjustment transactions 

applied to folders or brokers. Select these if there is a desire to print and send invoices for 

any transactions adjusting service charges to these classes. 

• Producer / CSR review assignment. This is used to set the Producer/CSR level that will 

be responsible for the review, edit and application of calculated bulk service charges for a 

particular account. That is, if the organization has 2 or more levels of Producer / CSR 

assignments on its folders and/or Brokers, it can select which level will be responsible for 

the service charge review process. When the system calculates a run of service charges, it 



will then apply the appropriate Producer / CSR name to each account to facilitate the 

review process. 

 

Once the desired rules are applied to the particular ABD, click OK or Apply to put them into 

force. OK will apply the rules and exit the function. Apply will apply the rules and leave the 

function open to permit the setting of rules for another ABD. 

 

If the rules are to be the same for all ABDs, simply create and save them for the first ABD and 

then click the Apply to All button. 

 

Calculating Bulk Service Charges: 

 

Once the system is set up and an appropriate level of maintenance of accounts receivable open 

items has taken place, it is time to calculate a bulk service charges run. To calculate a run, 

navigate to and double click Accounts Receivable on the Accounting tree and then click the 

Service Charges tab on the bottom of the viewer. From the toolbar that appears atop the viewer, 

click on the star icon (Figure 1.5) . When it is clicked, the user is presented with the Service 

Charge Cycle Detail form that appears as follows (Figure 1.6): 

 

Figure 1.5 

 
 

Figure 1.6 

 



 

The options available are as follows: 

 

• Agency, Branch and Department. The selections here determine the folder and broker 

accounts that are to be included in the bulk service charges run.  

 

Important Note: The Broker’s Workstation folder and broker accounts require the assignment of 

an ABD. Notwithstanding the assignment of an ABD to an account, it remains possible to have 

transactions of other ABDs applied to an account. For the purposes of bulk service charges 

calculations, the ABD selection in Exhibit 3 determines which accounts are calculated. It does 

NOT govern which transactions within an account are included in the calculation. For best 

results, the entire contents of an account must be considered in determining the requirement for 

an extent of any service charge to be applied. 

 

• Client Type. This control has options for All, Folders and Brokers. This determines what 

accounts are reviewed in the calculation. To minimize processing time, select only those 

classes for which service charges are desired. 

• Effective Date. This control defaults to the current System Date. This date is key to the 

service charge calculation because it is the date to which the due date on transactions are 

evaluated to determine the overdue status. Normally the Effective Date should closely 

approximate the real time calculation date as it makes sense that any calculation should 

be based on the most up-to-date information.  

• Description. Enter a description for the bulk service charges run. Make it meaningful as 

this description will appear in the accounting system and on any invoices or statements. 

A suggested description would be, “Service Charge at 31-July-2006”. 

 

Once the bulk service charges run options are selected, click the “Calculate” button to commence 

the computation of the bulk service charges. This process may take some time because it must 

assess the open item and due date status of each transaction for each affected account. 

 

When the calculation is complete, the user has the option to begin work on managing the run 

contents immediately or saving it for later access and management. To save the results, click 

“OK” to the Service Charge Cycle Detail form once the calculation is complete and the results 

are displayed in the grid in the lower part of the form. 

 

Reviewing and Managing Bulk Service Charges: 

 

Bulk service charge runs can be managed immediately upon their calculation or at some later 

time(s). 

 

If managing a run at a later time, it is first necessary to locate and open the desired run.  

 

All bulk service charges runs are displayed in a list that can be sorted and filtered to aid in their 

effective management. To access the list of runs, navigate to and double click Accounts 

Receivable on the Accounting tree and then click the Service Charges tab on the bottom of the 

viewer. The viewer will open and display a list of all service charges runs and their status. Over 

time this list can become lengthy, and it may be helpful to use the filtering tools to locate the 

desired run.  



To use a filter to locate a run, click on the toolbar icon featuring a funnel and lightning bolt (see 

Figure 1.7) to access the filter options. A dialog box as shown in Figure 1.8 will open. 

 

 

Figure 1.7 

 
 

Figure 1.8 

 
 

To use the filter, select the desired ABD level, a date range for run effective dates, and the 

desired status. Options for desired status include: posted, unposted, or all. The date ranges can be 

left blank if you don’t want to filter by date. Once the desired filter parameters are entered, click 

the “Apply Filter” button, and the list will redraw in accordance with your filter settings. To 

restore the full list, click the Remove Filter (the funnel with the X) icon on the service charges 

toolbar as shown in Figure 1.9. 

Figure 1.9 

 
 

To open and work with a particular service charge run, locate it in the list and double click its 

row. The Service Charge Detail form as in Figure 1.6 will open with the full account charge 

details shown in the lower window. At this point, users can review the accounts that met the 

service charge application test and the particulars to determine whether to proceed with the 

application of a service charge as calculated or overridden. 

 

The run detail grid on the Service Charge Run Detail form also has filter controls that allow a 

user to limit the accounts displayed to those with selected attributes including: ABD, client type 

(folder, broker or all) and Producer (Figure 1.11). Click on the Apply Filter button (Figure 1.10) 

on the form and select the desired filter parameters and then click OK . The list will then be 

filtered to show only those accounts that meet the parameters. This can be helpful to limit those 

in view to those a user may be responsible for. 

 

Figure 1.10 
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Figure 1.11 

 
 

The service charge detail grid presents the following information to assist in making decisions 

about whether to apply the calculated service charge and/or override the calculated amount. The 

information presented includes: 

 

• Apply: users select or de-select this field for each account to apply the calculated or 

overridden service charge amount. 

• Class: This will display a “B” if the account is a Broker or an “F” if it is a client folder. 

• ID: This is the account number/code for the particular account. 

• Name: The account name. 

• Rate: The service charges rate set on the particular client folder or broker item. 

• Calculated S/C: The calculated service charge based on the rate, open items and due 

dates. 

• Applied S/C: The service charge amount to be applied. This defaults to the calculated 

amount, but it may be overridden to a different amount if required.  

• A-B-D: The Agency, Branch and Department assignment of the particular account. 

• Producer: The name of the Producer or CSR assigned to the account at the level for that 

account’s ABD as set in the Service Charge Cycle Calculation Options for that ABD. 

• Overdue Debits: This is the amount of overdue open debits on the accounts. This is 

assessed based on the due date of the item, the required minimum number of days 

overdue as set in Service Charge Cycle Calculation Options for that ABD and the service 

charges run effective date. 

• Open Credits: The amount of any open credits (of any type). 

• Net Overdue: The amount if any by which the O/D Debits exceeds Open Credits. This is 

the amount that the service charge rate is applied to. 

• Prebill Credits: Reports any credits to the account other than payments with a prebill 

date. An item has a prebill date if it is dated later than the service charges run effective 

date. 

• Prebill Payments: Reports and payments on the account with a prebill date. These could 

be post-dated cheques, for example. 

• Prebill credits and prebill payments may indicate circumstances that justify the 

elimination or reduction of the system-calculated service charge. 

 



• Last Paid Date: Reports the date of the latest payment on the account. This may be 

helpful for assessing the payment habits of the account. 

• Changed By:  will collect the name of the user that overrides the calculated amount 

• Ref No.: As items are posted a reference number is created for each Service Charge.  

 

The contents of the service charge detail grid may be printed to enable the review of a hard copy. 

Print the grid by clicking the printer icon located immediately above it. The printout will reflect 

any filtering applied to the grid. 

 

When it is necessary to go to a client folder for more information to assist in making a service 

charge amount or application decision, the Service Charge Cycle Detail form can be minimized 

to permit a folder review. This will save time otherwise required to find the desired run, open the 

list and re-apply the desired filtering. This will also be helpful in situations where one is working 

on the service charges and must deal with a customer request. 

 

Upon review of an account’s information, the user has the following options: 

 

• Accept the service charge as calculated, so the account is selected for posting 

• Determine and apply a service charge of a different amount, enter it in the Applied S/C 

cell, and select the account for posting as overridden 

• Opt against applying a service charge at all, so the account is not selected for posting. 

 

Once the bulk service charges run has been reviewed, edited and marked for application, it can 

be posted. This is accomplished by clicking the “Post” button. When the run is posted, the 

selected service charges are applied to the respective accounts and printable invoices are created 

(if required in Service Charges Calculation Options, see Getting Started), and the service charge 

items will have a due date equal to the System Date of posting date plus x where x = Payment 

terms set on the Invoices tab in Demographics. 

 

Solving Problems: 

 

Occasionally a service charge is applied to an account in error so it becomes necessary to effect 

adjustments. The Broker’s Workstation provides two ways of dealing with these situations. 

 

The user can unpost the bulk service charges run containing the error(s). This can be 

accomplished by locating and opening the bulk service charges run containing the problem items 

and clicking the “Unpost” button. This will then undo the posting of the entire run. 

 

The availability of the Unpost function is subject to the following limitations that are necessary 

to protect the integrity of the accounting data: 

• The run may not be unposted if it is in a closed accounting month. 

• The run may not be unposted if the user does not possess the correct user rights. 

• The run may not be unposted if any of its individual charges are included in a committed 

accounts receivable reconciliation. 

• The run may not be unposted if any of its individual charges are adjusted by a Service 

Charge Adjustment (see below). 

 

Unposting a bulk service charges run is an excessive action that is unnecessary if all that is 

required is a correction of a small number of applied service charges. For the occasional 

correction of a service charge, use the Service Charge Adjustment function. This allows a user to 

reverse, reduce or increase a service charge to correct an error.  

 

 

 



The Service Charge Adjustment is accessed in two ways: 

• On the client folder ledger card, right click on the service charge to be adjusted and select 

“Service Charge Adjustment”. 

• On the Service Charge Cycle Detail form for the run containing the account to be 

adjusted, locate the service charge and right click on it to reveal the Service Charge 

Adjustment item. 

 

In either case, the user will be presented with a dialogue box in which the adjustment 

information can be entered. The controls will contain default information including the System 

Date for the effective date, a generic description that can be expanded on as appropriate, and a 

default adjustment amount equal to the amount of the original service charge times -1. (Figure 

1.12) 

Figure 1.12 

 
 

 

The deletion of a Service Charge Run is an option when the run was improperly calculated and it 

is not feasible to correct it via adjustments. A Service Charges Run may only be deleted if it is 

not posted. To delete a Service Charges Run, locate it in the list of runs, select it and click the 

“Delete” button on the Service Charges toolbar (see Figure 1.2). 

 

How it Works: 

 

The bulk service charge calculation works as follows: 

 

• When the Service Charge Calculation Details are set to “Calculate on Active Clients 

Only”, client folders that are marked as other than Active (on the Client Details tab) are 

not considered for service charge calculations. 

• Only accounts (folders and/or brokers) that are marked as “Apply service charge cycles 

to this account” will be subject to a bulk service charge calculation. This setting is located 

on the Client Info tab of a client folder and the Additional Information tab for broker 

Lists items. 

• Only those accounts that meet the ABD setting for the calculation will be considered in 

the bulk service charges run at hand. If an account is included in the selected ABD range, 

all transactions within it will be subject to the calculation regardless of their ABD 

assignment. This is so because it is essential that service charges be based on the overall 

balance situation within an account. Failure to do so can result in unintended results. 

• For the accounts that meet the required parameters as discussed above, the service charge 

is calculated as follows: 

o Compute the open overdue debit balance. 



o Compute the open credits aged current or later.The sum of the open overdue 

debits and the open credits is determined. If it is a net credit, there the account 

is not eligible for a service charge. 

o If there is a positive net overdue debit balance, the service charge rate 

applicable to that account is applied to arrive at the computed service charge. 

o If the computed service charge is greater than the minimum service charge 

specified in the Service Charges Calculation Options, a record is added to the 

run for that account. 

• When the bulk service charges cycle is posted, it applies debits to Accounts Receivable 

and credits a revenue account determined by the ServiceChargeRevenue Xref code. 
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2. Bank Reconciliation Deposit Roll Up  
 

At present the bank reconciliation tool presents deposits containing receipts of more than one 

date as multiple deposits representing the sum of each day’s receipts. In this situation, the bank 

reconciliation process is more difficult than it needs to be because a user must locate and verify 

the sum of the daily pieces of a deposit and make the multiple selections rather than being able to 

simply identify the deposit value in agreement with the bank statement and check it off. (Figure 

2.1) 

Figure 2.1 

 

 

With the following changes to the bank reconciliation, now a deposit is presented as one 

item/value regardless of the fact that it may contain receipts from more than one date. (Figure 

2.2) 

 

Figure 2.2 

 



 

3. Eliminate Tax Message  

 
The initial build of the TBW sales tax system provided message boxes after accepting all policy 

transactions that offered an opportunity to view or edit applied taxes or advising that no taxes 

were applied and offering an opportunity to add some. User feedback indicates that these pop-

ups on every transaction can be a nuisance. 

 

Notwithstanding the nuisance factor of these message boxes, they have a legitimate purpose. The 

review/edit option is important if it is necessary to adjust the tax applied based on the rules to 

take account of a special situation. The ability to add taxes when not otherwise required by the 

rules can be necessary can similarly be necessary. An example of the latter is the case of an off-

road vehicle on a policy containing automobiles. If the policy is coded as Auto, the tax rules will 

provide for no tax despite the fact that a portion of the coverage is indeed taxable.  

 

The main interface changes will be: 

 

• The elimination of: 

o The message box that is offered when the system applies no tax and offers the 

opportunity to do so, and  

o The message box that is offered when the system applies taxes and offers the 

opportunity to view and/or edit the taxes. 

 

• The addition of a “Taxes” button on the bottom of all policy entry forms. This will take 

the place of the two message boxes that are discontinued.  

 

 The new button will operate as follows: 

o It will be visible only if the sales tax system is enabled in Demographics. 

o It will be disabled until the user has input sufficient information about the subject 

policy transaction to enable the evaluation of the liability for taxes as set out in the 

Tax Associations. That is, the button will not be operable until ABD, Bill Type, 

Premium, and Policy Type are entered. 

o The user can click OK to the policy transaction form at this time and the system 

will evaluate the policy information in relation to the Tax Associations, calculate 

and apply the taxes and post the transaction without further notice. 

o Alternately, at that time the user can click the View/Edit Taxes button and the 

following will happen: 

� the system will evaluate the policy entry against the Tax Associations and 

determine what taxes, if any, to apply and calculate them. 

� The system will open a sub-form (use the current form as a basis) containing 

the calculated taxes. If none were applied, the form will be blank, but the user 

will be able to add a tax(es). If taxes were applied, the user will be able to edit 

or delete them or add another.  

� The taxes sub-form will have 2 buttons: 

� OK to accept the taxes, as amended, and close the form. This should set a 

flag that taxes are done and to be posted as is unless the policy data is 

subsequently changed before posting. 

� Cancel to close without changing the computed value(s), if any 

 

o On OK to the policy transaction form after the user has edited the taxes above, the 

system will post the transaction using the tax information accepted by the user. 

o If after editing the tax, the user changed any of the policy data elements that 

potentially impact taxation (ABD, Premium, Bill Type, Policy Type), the system 

should provide message box indicating that the rule-based taxes, if any, may have 



changed and offer the opportunity to keep the previous edits or recalculate and 

review. If the user opts to retain the edits, the message box closed and the user is 

free to post the transaction. If the user opts to recalculate and review, the message 

box closes and the previous tax calculations are discarded and the flag removed. 

The View/Edit Taxes button remains available for use and the cycle continues. 

That is, the user can view or edit then post or go directly to post with the rules-

based results. 

 

4. Policies In Force Report: 

 
With this new feature, users can return a summary or details report by producer of the ‘In 

Force’ policy count, premium, and commission. This new report is located under the Reports 

menu on the desktop side of the program. (Figures 4.1-4.3) 

 

Figure 4.1 – Policies In Force entry screen 

 
 

 

Figure 4.2 – Summary results  

 
 

 

Figure 4.3 – Detail results  

 
 



5. Direct Check In  

 
When several documents are checked out on a client folder some functions can become very 

slow.  To speed things up this new code will no longer check in and out the entire client folder 

when changes are made.  It will post only the changes for the document you’re working on 

directly to the database. 

 

When doing any of the following you should notice that the client folder is not checked in/out.  

This will result in much faster processing. 

• Creating new Policy Transactions 

• Editing existing Policy Transactions 

• Marking Requesting Docs for upload 

• Marking New Business Applications for Upload 

• Transacting Policy Documents 

• Un-transacting Policy Documents 
 

6. New .tif image buttons 

  
    With this new feature, users now have the ability to import multi-page TIF, TIFF images to a 

policy and filter thru all pages on that image. (Figure 6.1 –new multi-page tif icons) 

 

(Figure 6.1 – new multi-page tif icons) 

 

 
 

7. Word processor Label Exclusions 
 

When printing a label mail merge users can select exclusions as well as a starting point for the 

first sheet of labels (Figure 7.1).  This window will be displayed after the user selects the desired 

printer. If user selects exclude, then a new screen will be presented and the user can select the 

appropriate boxes to be excluded (Figure 7.2 – red items are excluded items).  

 

(Figure 7.1) 

 
 

 

 

 

 



(Figure 7.2 – label exclusions) 
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8. Word Processor Field Grouping 

 
When the user goes into a letter and tries to insert a field, there will be a retrieving data fields 

tool that will run, and an insert fields window will be presented. This retrieve window will run 

each time a new/existing letter is opened.  

 

The user will notice two new insert field headers: Property Coverage and Auto Coverage. Under 

each folder they will find sub folders and then under each of those they will find the appropriate 

insert fields. (Figure 8.1) 

 

 

 

 

 

 

 

 

 

 



Figure 8.1 

 
 

Once an insert fields is selected and added to the letter the user can now double click on the field 

and Format Data Field screen will come up. (Figure 8.2) 

 

Figure 8.2 

 
 

With this screen the user can specify how they want the related field to be grouped. 

• Category: Let’s the user know what insert field category this came from. 

• Name: is the name on the insert field user is on. 

• Data Source: A Data Source is a document to which the corresponding Field Groups 

reference. Data Sources can be intelliquote, Applications, or Policies. Ex: A template 



with two Data Source groups will offer the ability to pull forth data from multiple 

documents; such as Person A from Policy A and Person A from Policy B 

• Field Group: A Field Group is a collection of fields that share the same Data Source 

based on the fields Category. Ex: A template with two ‘Person’ Field Groups will offer 

the ability to pull forth data from multiple people in the corresponding Data Source. 

• Replicate: Field replication is the dynamic population of field data for all items within a 

Data Source. This eliminates the need to insert fields for each item in a Data Source. Ex: 

A template with a replicate ‘Person’ Field will pull forth data for that field for all persons 

the corresponding Data Source. Hence, if the Data Source contains two persons the 

replicated field will pull data for both those persons. Replication involving multiple fields 

is best used in a table for formatting purposes. 

• Separator: The field replication separator defines how the data for a replicated field is 

returned. Ex: A template with a replicated ‘Persons’ Field being separated with a New 

Line will place each returned item for that field on it’s own line in a document. 

 

9. Word Processor Custom Inserts  

 
 Users have the ability to save an entire document or part of a document as a Custom Insert. 

 Simply go to Tools > Inserts > Create Custom Insert or press Ctrl+F9, type the name and 

 description of the insert and OK (Figure 9.1 & 9.2)  

 

Figure 9.1 

 
 

Figure 9.2 

 
 

 

To insert this later you can go to Tools > Inserts > Custom inserts or you can press Ctrl+F8 

(Figure 9.3).  You then have a list to scroll through and select or you can type the name of the 

insert and the matching name will be selected.  Press OK or double-click on the Insert name to 

insert into the document (Figure 9.4). 

 

 

 

 

 



Figure 9.3 

 
 

Figure 9.4 

 
 

 

A User can also create and insert these Custom Inserts by simply right-clicking in the document 

and clicking the appropriate option. (Figure 9.5) 

 

Figure 9.5 
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10. Word Processor Ask Variable 
 

This Feature allows the user to insert an Ask field where they can enter their own question.  

When the template is dragged and dropped it will ask you that question and wait for a response. 

 

How to Use:  

• Open new word processor document or existing document 

• Go to insert fields and you will find a new folder called Miscellaneous 

• Under this folder there is an insert field of ‘ASK’ 

• Double click to insert this field in the desired area on the word processor document. 

• After inserted, double click the insert field ‘ASK’ to be presented with the following 

format data info screen. (Figure 10.1)          

Figure 10.1 

 
 

• Category: lists the folder where this insert field resides. 

• Question: This is where the Question (Ask) is inputted. 

• Data Source: A Data Source is a document to which the corresponding Field Groups 

reference. Data Sources can be Intelliquote’s, Applications, or Policies. 

• Field Group: A Field Group is a collection of fields that share the same Data Source 

based on the fields Category. 

• Replicate: Field replication is the dynamic population of field data for all items within a 

Data Source. This eliminates the need to insert field for each item in a Data Source. 

• Enter the Question that would be required then hit OK to apply. (Figure 10.2) 

Figure 10.2 

 



 

• Publish the new word processor document then close. 

• Drag and Drop the letter to the folder or document desired. 

• Depending on other data inserted in the letter, a new window will be presented with the 

‘ASK’ question. (Figure 10.3) 

Figure 10.3 

 
 

• Enter the appropriate answer and continue on to the Letter. 

• Once inside the letter, the ‘Ask’ field should not be populated with the appropriate 

answer entered. 
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11. Word Processor Math Equations 

 
How to use:  

• Open a new or existing word processor document (Figure 11.1) 

 

Figure 11.1 

 
 

 

• Under the Insert menu, select the Field option. This will present a new window with all 

the insert fields available. (Figure 11.2) 

 

 

 

 



 

Figure 11.2 

 
 

There should be a new folder in the list called Mathematics-> formula. (Figure 11.3) 

Figure 11.3 

 
 

 

Select where you would like to insert the ‘formula’, and then double click on the ‘formula’ 

insert field. Once this has been done a new Math Formula Editor Window will be presented. 

(Figure 11.4) 
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Figure 11.4 

 
 

With this new Math Formula Editor window, users can manually type in a math equation or 

they can create an equation by using other insert fields.  User also has the option of Number 

or Currency format, which is located in the bottom left of editor window. (Figure 11.5) 

Figure 11.5 

 
 

 

• After the equation has been created, click ok 

• To edit a ‘Formula’, the user can double click on the formula field and the Math Equation 

- Editor window will reopen, ready for editing. 

• While in the editor window, if user has forgotten what the equations purpose was, ex. 

5+(a) (what does (a) stand for?), select the ‘ab’ icon from the toolbar, then use the drop 

down menu to find what “(a)” stands for in the equation.(figure 11.6) 

Figure 11.6 
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12.  Checkout Abeyance folder  
 

This enhancement gives the user the ability to check out a client folder via right click on 

Abeyance list. 

 

When you double-click the Abeyance icon on the tree and are presented with the Abeyances, 

users now have the ability to right-click on a Client Abeyance and check out the client 

folder.(figure 12.1, 12.2) 

 

(Figure 12.1 –Abeyance Icon)  

 
 

 

(Figure 12.2- Abeyance List – check out folder) 

 



 

(Figure 12.2 cont.) 
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13.  Abeyance History  

 
Currently TBW does not display the history of an abeyance item if edited. With this 

enhancement, the client can edit the abeyance and the history of that abeyance will be stored 

within the database for later retrieval. The current edit will be shown on the newly edited 

abeyance item, also maintaining the original abeyance created date. 

 

14.  Abeyance Changes  

 
• Days Ahead/Back is now BOTH, not either.  Caption now says "Show Days Ahead and 

Back" instead of  "Show Days Ahead/Back (eg -30 or 30)" (Figure 14.1) 

• There is a need to show ALL outstanding abeyances regardless of date.   The system will 

nowl now allow the From and To Dates to be blank if the view is set to Outstanding Only 

AND the Days Ahead/Back = 0.   If your other filters are set to "All" then the result will 

be all outstanding abeyances regardless of date.  (Both dates must be blank) 

 

This can be defaulted and will work on both the client folder and main abeyance screen. 



 

Figure 14.1 
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15.  Cancel Forced Activity  

 
This enhancement gives the user the ability to Cancel a Forced Activity and not check in the 
folder. 

• The user will no longer receive a message indicating that a Forced Activity is required 

and will now be sent directly to the Forced Activity. 

• The user will be able to Cancel the Forced Activity 



 

16.  Sorted User Rights  

 
General User Rights have now been sorted into appropriate sections for easier viewing and 

applying. (Figure 16.1) 

 

Figure 16.1 

 

 

 

17.  New Webconnect Items  

 
We have now added PortagePQP, Kingsway, Blue Cross MB, Gore Mutual, AXA, Dominion, 

Aviva, Economical, ING Canada, Insurance Bureau of Canada. To enable these items, user rights 

will need to setup accordingly and then username/password info can be setup under appropriate 

webconnect item. 

 

Also available with new webconnect items, we now have the option of doing a policy lookup 

right from the CSIO or manually entered policy. This feature is currently available with 

Wawanesa, Gore Mutual, Dominion of Canada, Axa, and Kingsway. To use this feature the 

webconnect username/password info needs to be entered in appropriate screen, then when a user 

opens a policy they will see the following icon on there toolbar that will take them into the 

insurance company website to do a policy lookup. (figure 17.1, 17.2) 
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Figure 17.1 

 

 

Figure 17.2 

 

 

 



 

 

 

18.  Vehicle Substitution  
 

 Currently the only way to do a substitution is to edit the current vehicle, change the VIN and/or 

Year Built and answer “YES” when asked if this is now a completely different vehicle. This 

method of substitution would maintain the current driver and claims assignments however it 

would still appear internally as an add/delete and show as such on the change memo. 

 

In order to avoid confusion and offer more functionality we will now display a dedicated 

“Substitute” button. 

 

With this new “Substitute” button that appears on the \ Optional Coverages screen (Figure 18.1), 

depending on what vehicle type is selected under “Currently Selected Items” the user may be 

asked which type of vehicle they would like to substitute the current vehicle with (Figure 18.2 & 

18.3). After making a selection Intelliquote will make all the necessary changes behind the 

scenes and then open the Coverage Items screens for editing (Figure 18.4). 

 

Figure 18.1 

 

 

Figure 18.2 

 

 

 

 

 

 

 



 

Figure 18.3 

 

 

 

Figure 18.4 

 

 

 

Please run the TBW Remote Update Utility to access these changes. For assistance in using 

these new features, please contact our Support Team at 1-888-291-3588. 

 

Please share this information with all TBW users in your office(s) and thank you for using 

TBW. 

 

Yours truly, 
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